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DA 99-1615

Released:  August 13, 1999

PHASE II 220 MHz SERVICE APPLICATIONS ACCEPTED FOR FILING
AUCTION No. 24

Pleading Cycle Established

Report No. AUC-24-F (Auction No. 24)

The long-form applications (FCC Form 601) for Phase II 220 MHz licenses listed in Attachment A
have been found, upon initial review, accepted for filing.  The Commission may return or dismiss any
application if it is found, upon further examination, to be defective or not in conformance with the
Commission's rules.  See 47 C.F.R. § 1.933(b).   In addition, applications listed in Attachment A that are
pending with associated petitions for waiver are accepted conditioned on resolution of such requests.

Petitions to deny the applications listed in Attachment A must be filed no later than
August 23, 1999, which is ten (10) days after the date of this Public Notice.  See 47 C.F.R. § 1.2108(b). 
Oppositions to a petition to deny must be filed no later than five (5) business days after the date on which
the petition to deny is filed.  See 47 C.F.R. § 1.2108(c).  Replies to the opposition must be filed no later
than five (5) business days after the date on which the opposition is filed.  See 47 C.F.R. § 1.2108(c).  All
filings concerning Phase II 220 MHz long-form applications should refer to Report No. AUC-24-F
(Auction No. 24), as well as the specific file numbers of the individual applications.

An original and four copies of all pleadings must be filed with the Commission's Secretary,
Magalie Roman Salas, Office of the Secretary, Federal Communications Commission, 445 Twelfth Street,
S.W., Room TW-A325, Washington, DC 20054, in accordance with section 1.51(c) of the Commission's
rules.  See 47 C.F.R. § 1.51(c).  In addition, one copy of each pleading must be delivered to each of the
following locations: (1) the Commission's duplicating contractor, International Transcription Service, Inc.
(ITS), 1231 20th Street, N.W., Washington, DC 20036; (2) Office of Public Affairs, Wireless
Telecommunications Bureau, 445 Twelfth Street, S.W., Room CY-C314, Washington, DC 20554; (3)
Scott A. Mackoul, Policy and Rules Branch, Commercial Wireless Division, Wireless Telecommunications
Bureau, 445 Twelfth Street, S.W., 4-A230, Washington, DC 20554; and (4) Terry L. Fishel, Licensing
and Technical Analysis Branch, Commercial Wireless Division, Wireless Telecommunications Bureau,
1270 Fairfield Road, Gettysburg, PA 17325.

The applications listed in Attachment A are available to the public for electronic viewing in the
Commission's Universal Licensing System ("ULS").  Instructions for obtaining and using are contained in
Attachments B and C of this Public Notice.
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After the pleading cycle, the Wireless Telecommunications Bureau will release a public notice
listing the applicants to whom the Commission is prepared to grant licenses.  All winning bidders will be
required to pay the balance of their winning bids in a lump sum payment within ten (10) business days
following the release of that public notice.  See 47 C.F.R.§ 90.1015.  Licenses will be awarded upon the
full and timely payment of the winning bids and any applicable late fees.

Applicants wishing to amend their long-form applications must do so electronically via ULS.  For
technical assistance in using ULS for viewing applications or making amendments to applications, please
contact the FCC Technical Support Hotline at (202) 414-1250.  All calls to the FCC Technical Support
Hotline are recorded.  For further information on procedural or legal matters contact Scott A. Mackoul at
(202) 418-7240.

This Public Notice contains the following attachments:

Attachment A: Auction No. 24 Applications Accepted for Filing

Attachment B: Instructions for Searching for Applications Listed in Attachment A using ULS.

Attachment C: Accessing the FCC Network Using Windows 95/98
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File
Number

Applicant Name Market/Channel
Block

Market Description

000001680
6

220 MHz Auction Group BEA016 D Staunton, VA-WV

000001680
6

220 MHz Auction Group BEA017 D Roanoke, VA-NC-WV

000001680
6

220 MHz Auction Group BEA042 B Asheville, NC

000001680
6

220 MHz Auction Group BEA042 D Asheville, NC

000001680
6

220 MHz Auction Group BEA044 D

000001680
6

220 MHz Auction Group BEA045 B Johnson City-Kingsport-Bristol, TN-

000001680
6

220 MHz Auction Group BEA045 C Johnson City-Kingsport-Bristol, TN-

000001680
6

220 MHz Auction Group BEA045 D Johnson City-Kingsport-Bristol, TN-

000001680
6

220 MHz Auction Group BEA046 C Hickory-Morganton, NC-TN

000001680
6

220 MHz Auction Group BEA046 D Hickory-Morganton, NC-TN

000001680
6

220 MHz Auction Group BEA048 B Charleston, WV-KY-OH

000001680
6

220 MHz Auction Group BEA051 B Columbus, OH

000001680
6

220 MHz Auction Group BEA052 A Wheeling, WV-OH

000001680
6

220 MHz Auction Group BEA052 B Wheeling, WV-OH

000001680
6

220 MHz Auction Group BEA091 B Fort Smith, AR-OK

000001680
6

220 MHz Auction Group BEA091 D Fort Smith, AR-OK

000001680
6

220 MHz Auction Group BEA092 B Fayetteville-Springdale-Rogers, AR-

000001680
6

220 MHz Auction Group BEA093 B Joplin, MO-KS-OK

000001680
6

220 MHz Auction Group BEA093 D Joplin, MO-KS-OK

000001680
6

220 MHz Auction Group BEA094 A Springfield, MO

000001680 220 MHz Auction Group BEA094 B Springfield, MO
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6
000001680

6
220 MHz Auction Group BEA126 B Western Oklahoma, OK

000001680
6

220 MHz Auction Group BEA136 C Hobbs, NM-TX

000001680
6

220 MHz Auction Group BEA168 D Pendleton, OR-WA

000001680
6

220 MHz Auction Group EAG003 F

000001680
6

220 MHz Auction Group EAG004 I

000001668
3

American Pacific Inc. BEA056 B

000001668
3

American Pacific Inc. BEA059 D Green Bay, WI-MI

000001668
3

American Pacific Inc. BEA060 D Appleton-Oshkosh-

000001668
3

American Pacific Inc. BEA104 D Madison, WI-IA-IL

000001668
3

American Pacific Inc. BEA108 D

000001668
3

American Pacific Inc. BEA173 A Guam and Northern Mariana Islands

000001668
3

American Pacific Inc. BEA173 B Guam and Northern Mariana Islands

000001668
3

American Pacific Inc. BEA173 C Guam and Northern Mariana Islands

000001668
3

American Pacific Inc. BEA173 D Guam and Northern Mariana Islands

000001668
3

American Pacific Inc. BEA173 E Guam and Northern Mariana Islands

000001668
3

American Pacific Inc. BEA175 A American Samoa

000001668
3

American Pacific Inc. BEA175 B American Samoa

000001668
3

American Pacific Inc. BEA175 C American Samoa

000001668
3

American Pacific Inc. BEA175 D American Samoa

000001668
3

American Pacific Inc. BEA175 E American Samoa

000001679
6

AreaWide Communications Inc. BEA001 D

000001679 AreaWide Communications Inc. BEA013 B Washington-Baltimore, DC-MD-VA-
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6
000001679

6
AreaWide Communications Inc. BEA016 B Staunton, VA-WV

000001679
6

AreaWide Communications Inc. BEA045 A Johnson City-Kingsport-Bristol, TN-

000001672
4

DATA RADIO MANAGEMENT CO.,
INC.

BEA002 C

000001672
4

DATA RADIO MANAGEMENT CO.,
INC.

BEA007 A Rochester, NY-PA

000001672
4

DATA RADIO MANAGEMENT CO.,
INC.

BEA053 E Pittsburgh, PA-WV

000001672
4

DATA RADIO MANAGEMENT CO.,
INC.

BEA099 E Kansas City, MO-KS

000001672
4

DATA RADIO MANAGEMENT CO.,
INC.

BEA125 E Oklahoma City, OK

000001681
3

Douglas, Nancy J BEA044 A

000001681
3

Douglas, Nancy J BEA072 B Paducah, KY-IL

000001681
3

Douglas, Nancy J BEA098 B Columbia, MO

000001681
3

Douglas, Nancy J BEA104 A Madison, WI-IA-IL

000001681
3

Douglas, Nancy J BEA136 D Hobbs, NM-TX

000001681
3

Douglas, Nancy J BEA137 C

000001646
6

Gallagher, Maureen BEA058 E Northern Michigan, MI

000001646
6

Gallagher, Maureen BEA059 E Green Bay, WI-MI

000001646
6

Gallagher, Maureen BEA093 E Joplin, MO-KS-OK

000001646
6

Gallagher, Maureen BEA094 E Springfield, MO

000001646
6

Gallagher, Maureen BEA098 E Columbia, MO

000001646
6

Gallagher, Maureen BEA105 E La Crosse, WI-MN

000001646
6

Gallagher, Maureen BEA108 E

000001646
6

Gallagher, Maureen BEA126 E Western Oklahoma, OK

000001676 GEMC 220, LLC BEA036 C Dothan, AL-FL-GA
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7
000001676

7
GEMC 220, LLC BEA037 A

000001676
7

GEMC 220, LLC BEA037 B

000001676
7

GEMC 220, LLC BEA037 D

000001676
7

GEMC 220, LLC BEA037 E

000001676
7

GEMC 220, LLC BEA038 A

000001676
7

GEMC 220, LLC BEA038 B

000001676
7

GEMC 220, LLC BEA039 A Columbus, GA-AL

000001676
7

GEMC 220, LLC BEA039 D Columbus, GA-AL

000001676
7

GEMC 220, LLC BEA043 A Chattanooga, TN-GA

000001676
7

GEMC 220, LLC BEA074 B Huntsville, AL-TN

000001676
7

GEMC 220, LLC BEA078 B Birmingham, AL

000001676
7

GEMC 220, LLC BEA079 A Montgomery, AL

000001653
2

Greene, Jeremy A (*) BEA160 E Los Angeles-Riverside-Orange
County, CA-AZ

000001666
4

Havens, Warren C BEA001 A

000001666
4

Havens, Warren C BEA001 B

000001666
4

Havens, Warren C BEA001 C

000001666
4

Havens, Warren C BEA001 E

000001666
4

Havens, Warren C BEA002 A

000001666
4

Havens, Warren C BEA004 A Burlington, VT-NY

000001666
4

Havens, Warren C BEA004 B Burlington, VT-NY

000001666
4

Havens, Warren C BEA004 D Burlington, VT-NY

000001666 Havens, Warren C BEA006 C Syracuse, NY-PA
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4
000001666

4
Havens, Warren C BEA006 D Syracuse, NY-PA

000001666
4

Havens, Warren C BEA009 C State College, PA

000001666
4

Havens, Warren C BEA011 A Harrisburg-Lebanon-Carlisle, PA

000001666
4

Havens, Warren C BEA013 C Washington-Baltimore, DC-MD-VA-

000001666
4

Havens, Warren C BEA014 D Salisbury, MD-DE-VA

000001666
4

Havens, Warren C BEA016 A Staunton, VA-WV

000001666
4

Havens, Warren C BEA016 C Staunton, VA-WV

000001666
4

Havens, Warren C BEA045 E Johnson City-Kingsport-Bristol, TN-

000001666
4

Havens, Warren C BEA053 A Pittsburgh, PA-WV

000001666
4

Havens, Warren C BEA053 C Pittsburgh, PA-WV

000001666
4

Havens, Warren C BEA058 A Northern Michigan, MI

000001666
4

Havens, Warren C BEA058 D Northern Michigan, MI

000001666
4

Havens, Warren C BEA059 A Green Bay, WI-MI

000001666
4

Havens, Warren C BEA059 C Green Bay, WI-MI

000001666
4

Havens, Warren C BEA060 A Appleton-Oshkosh-

000001666
4

Havens, Warren C BEA061 A Traverse City, MI

000001666
4

Havens, Warren C BEA061 B Traverse City, MI

000001666
4

Havens, Warren C BEA061 D Traverse City, MI

000001666
4

Havens, Warren C BEA063 B Milwaukee-Racine, WI

000001666
4

Havens, Warren C BEA091 E Fort Smith, AR-OK

000001666
4

Havens, Warren C BEA092 D Fayetteville-Springdale-Rogers, AR-

000001666 Havens, Warren C BEA094 C Springfield, MO
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4
000001666

4
Havens, Warren C BEA105 C La Crosse, WI-MN

000001666
4

Havens, Warren C BEA105 D La Crosse, WI-MN

000001666
4

Havens, Warren C BEA108 A

000001666
4

Havens, Warren C BEA108 B

000001666
4

Havens, Warren C BEA109 A Duluth-Superior, MN-WI

000001666
4

Havens, Warren C BEA109 B Duluth-Superior, MN-WI

000001666
4

Havens, Warren C BEA109 C Duluth-Superior, MN-WI

000001666
4

Havens, Warren C BEA109 D Duluth-Superior, MN-WI

000001666
4

Havens, Warren C BEA110 A Grand Forks, ND-MN

000001666
4

Havens, Warren C BEA110 B Grand Forks, ND-MN

000001666
4

Havens, Warren C BEA110 C Grand Forks, ND-MN

000001666
4

Havens, Warren C BEA110 D Grand Forks, ND-MN

000001666
4

Havens, Warren C BEA111 A

000001666
4

Havens, Warren C BEA111 B

000001666
4

Havens, Warren C BEA111 C

000001666
4

Havens, Warren C BEA111 D

000001666
4

Havens, Warren C BEA111 E

000001666
4

Havens, Warren C BEA112 A Bismarck, ND-MT-SD

000001666
4

Havens, Warren C BEA112 B Bismarck, ND-MT-SD

000001666
4

Havens, Warren C BEA112 C Bismarck, ND-MT-SD

000001666
4

Havens, Warren C BEA112 D Bismarck, ND-MT-SD

000001666 Havens, Warren C BEA113 B Fargo-Moorhead, ND-MN
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4
000001666

4
Havens, Warren C BEA113 C Fargo-Moorhead, ND-MN

000001666
4

Havens, Warren C BEA113 D Fargo-Moorhead, ND-MN

000001666
4

Havens, Warren C BEA114 C Aberdeen, SD

000001666
4

Havens, Warren C BEA114 D Aberdeen, SD

000001666
4

Havens, Warren C BEA115 C Rapid City, SD-MT-ND-NE

000001666
4

Havens, Warren C BEA115 D Rapid City, SD-MT-ND-NE

000001666
4

Havens, Warren C BEA120 C Grand Island, NE

000001666
4

Havens, Warren C BEA120 D Grand Island, NE

000001666
4

Havens, Warren C BEA121 C North Platte, NE-CO

000001666
4

Havens, Warren C BEA121 D North Platte, NE-CO

000001666
4

Havens, Warren C BEA126 D Western Oklahoma, OK

000001666
4

Havens, Warren C BEA129 E San Angelo, TX

000001666
4

Havens, Warren C BEA135 E Odessa-Midland, TX

000001666
4

Havens, Warren C BEA137 D

000001666
4

Havens, Warren C BEA138 C Amarillo, TX-NM

000001666
4

Havens, Warren C BEA138 D Amarillo, TX-NM

000001666
4

Havens, Warren C BEA142 C Scottsbluff, NE-WY

000001666
4

Havens, Warren C BEA142 D Scottsbluff, NE-WY

000001666
4

Havens, Warren C EAG001 G

000001676
8

Intek License Acquisition Corporation BEA005 A Albany-Schenectady-Troy, NY

000001676
8

Intek License Acquisition Corporation BEA007 D Rochester, NY-PA

000001676 Intek License Acquisition Corporation BEA036 B Dothan, AL-FL-GA
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8
000001676

8
Intek License Acquisition Corporation BEA036 D Dothan, AL-FL-GA

000001676
8

Intek License Acquisition Corporation BEA036 E Dothan, AL-FL-GA

000001676
8

Intek License Acquisition Corporation BEA039 C Columbus, GA-AL

000001676
8

Intek License Acquisition Corporation BEA056 A

000001676
8

Intek License Acquisition Corporation BEA067 E Indianapolis, IN-IL

000001676
8

Intek License Acquisition Corporation BEA073 B Memphis, TN-AR-MS-KY

000001676
8

Intek License Acquisition Corporation BEA075 D Tupelo, MS-AL-TN

000001676
8

Intek License Acquisition Corporation BEA076 D Greenville, MS

000001676
8

Intek License Acquisition Corporation BEA077 C Jackson, MS-AL-LA

000001676
8

Intek License Acquisition Corporation BEA077 D Jackson, MS-AL-LA

000001676
8

Intek License Acquisition Corporation BEA079 E Montgomery, AL

000001676
8

Intek License Acquisition Corporation BEA080 E

000001676
8

Intek License Acquisition Corporation BEA081 D Pensacola, FL

000001676
8

Intek License Acquisition Corporation BEA081 E Pensacola, FL

000001676
8

Intek License Acquisition Corporation BEA084 C Baton Rouge, LA-MS

000001676
8

Intek License Acquisition Corporation BEA085 E

000001676
8

Intek License Acquisition Corporation BEA088 C Shreveport-Bossier City, LA-AR

000001676
8

Intek License Acquisition Corporation BEA088 D Shreveport-Bossier City, LA-AR

000001676
8

Intek License Acquisition Corporation BEA089 A

000001676
8

Intek License Acquisition Corporation BEA089 B

000001676
8

Intek License Acquisition Corporation BEA089 C

000001676 Intek License Acquisition Corporation BEA089 D
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8
000001676

8
Intek License Acquisition Corporation BEA089 E

000001676
8

Intek License Acquisition Corporation BEA091 C Fort Smith, AR-OK

000001676
8

Intek License Acquisition Corporation BEA092 A Fayetteville-Springdale-Rogers, AR-

000001676
8

Intek License Acquisition Corporation BEA093 C Joplin, MO-KS-OK

000001676
8

Intek License Acquisition Corporation BEA114 A Aberdeen, SD

000001676
8

Intek License Acquisition Corporation BEA114 B Aberdeen, SD

000001676
8

Intek License Acquisition Corporation BEA115 A Rapid City, SD-MT-ND-NE

000001676
8

Intek License Acquisition Corporation BEA115 B Rapid City, SD-MT-ND-NE

000001676
8

Intek License Acquisition Corporation BEA120 A Grand Island, NE

000001676
8

Intek License Acquisition Corporation BEA120 B Grand Island, NE

000001676
8

Intek License Acquisition Corporation BEA121 A North Platte, NE-CO

000001676
8

Intek License Acquisition Corporation BEA121 B North Platte, NE-CO

000001676
8

Intek License Acquisition Corporation BEA123 E

000001676
8

Intek License Acquisition Corporation BEA124 C Tulsa, OK-KS

000001676
8

Intek License Acquisition Corporation BEA126 A Western Oklahoma, OK

000001676
8

Intek License Acquisition Corporation BEA126 C Western Oklahoma, OK

000001676
8

Intek License Acquisition Corporation BEA130 E Austin-San Marcos, TX

000001676
8

Intek License Acquisition Corporation BEA132 E Corpus Christi, TX

000001676
8

Intek License Acquisition Corporation BEA134 E San Antonio, TX

000001676
8

Intek License Acquisition Corporation BEA135 D Odessa-Midland, TX

000001676
8

Intek License Acquisition Corporation BEA136 B Hobbs, NM-TX

000001676 Intek License Acquisition Corporation BEA137 E
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8
000001676

8
Intek License Acquisition Corporation BEA142 A Scottsbluff, NE-WY

000001676
8

Intek License Acquisition Corporation BEA142 B Scottsbluff, NE-WY

000001676
8

Intek License Acquisition Corporation EAG002 I

000001676
8

Intek License Acquisition Corporation EAG003 G

000001667
9

Police Emergency Radio Services,
Inc.

BEA005 C Albany-Schenectady-Troy, NY

000001667
9

Police Emergency Radio Services,
Inc.

EAG002 F

000001667
9

Police Emergency Radio Services,
Inc.

EAG004 H

000001680
1

Rush Network Corp. BEA124 E Tulsa, OK-KS

000001680
1

Rush Network Corp. BEA133 E McAllen-Edinburg-Mission, TX

000001649
8

Supreme Radio Communications,
Inc.

BEA100 D Des Moines, IA-IL-MO

000001649
8

Supreme Radio Communications,
Inc.

BEA103 A Cedar Rapids, IA

000001649
8

Supreme Radio Communications,
Inc.

BEA103 B Cedar Rapids, IA

000001649
8

Supreme Radio Communications,
Inc.

BEA103 D Cedar Rapids, IA

000001649
0

The Elkin Group, Inc. BEA004 C Burlington, VT-NY

000001631
6

Thomas Mr., Douglas BEA008 C Buffalo-Niagara Falls, NY-PA

000001631
6

Thomas Mr., Douglas BEA052 C Wheeling, WV-OH

000001631
6

Thomas Mr., Douglas BEA054 B

000001677
0

Wireless Communications
Technologies, Inc.

BEA059 B Green Bay, WI-MI

000001677
0

Wireless Communications
Technologies, Inc.

BEA060 B Appleton-Oshkosh-

000001677
0

Wireless Communications
Technologies, Inc.

BEA099 B Kansas City, MO-KS

000001677
0

Wireless Communications
Technologies, Inc.

BEA105 A La Crosse, WI-MN

000001677 Wireless Communications BEA108 C
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0 Technologies, Inc.
000001677

0
Wireless Communications

Technologies, Inc.
BEA113 A Fargo-Moorhead, ND-MN

000001677
0

Wireless Communications
Technologies, Inc.

BEA122 D Wichita, KS-OK

000001677
0

Wireless Communications
Technologies, Inc.

BEA123 C
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Attachment B

INSTRUCTIONS FOR SEARCHING FOR
APPLICATIONS FILED FOR PHASE II 220 MHz SERVICE AUCTION 24

This attachment provides instructions for electronically searching the FCC Network for a specific
application or applications on file with the Commission.  The following instructions relate specifically to
searching for applications filed in response to Auction 24.

To search the FCC Network for an application, you must first connect to the FCC Network.  Attachment C
describes how Windows 95/98 users can connect to the FCC Network using the Dial-Up Networking
features of Windows 95/98.

We recommend that you use Netscape Communicator 4.51 or 4.61 (Internet web browser software) to use
ULS for application searches.  To download Netscape Communicator 4.61 free of charge, access the
Netscape download site at http://home.netscape.com/download/.

Conventions

The instructions in this attachment use the following typographic conventions:

bold Represents objects on the screen that you click with the mouse pointer, including buttons,
Internet links, icon, tabs, menu items (e.g., Cancel button, Auctions link, Save option in
the File menu).

italic Represents field names or areas of a screen (e.g., Licensee Name field, Applicant
Information area of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions.  For
example, if you are instructed to type http://www.fcc.gov, you should type all of the
characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information and then press the
ENTER key.

Performing an Application Search

Once you have connected to the FCC Network, follow the procedures below to search for an application. 
You may click the ? (Help) button at anytime for additional information on using Application Search.

1. Connect to the FCC Network using one of the following options:

Note:  If your PC is connected to a network, you must use a secure proxy to access the FCC
Network.  Consult your Network Administrator.
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Dial-Up Access

a. Use Dial-Up Networking in Windows 95/98 to connect to the FCC Network (see Attachment
D).

b. Start your web browser.  In the location field of the web browser screen, type
http://wtbwww05.fcc.gov.  Then press the ENTER key.

Internet Access

a. Start your web browser and connect to the Internet using your Internet Service Provider.

b. In the location field of the web browser screen, type http://www.fcc.gov/wtb/uls.  Then press
the ENTER key.

2. Verify that Java and JavaScript are enabled in your web browser preferences.  Additionally, the
preferences must specify “Accept all cookies.”  Refer to your web browser Help facility for more
information.

3. On the Universal Licensing System main page, click the Application Search button, located on the left side of
the page.  The Application Search screen will then appear.  This screen contains several data entry fields used for
specifying search criteria.

Note:  Application Search utilizes "cookies".  If you are receiving a notification message when accepting a
cookie, we recommend that you disable this message in your web browser options.  Please consult you web
browser Help facility for more information.

4. Select the type of search by clicking the down arrow in the Select Search Type field to obtain a
menu containing the following options.  Select General and click the Continue button.

5. The Application Search screen appears.  This screen contains several data entry fields used for
specifying the criteria for your application search.  Specify the search criteria necessary to locate
the desired application.  Please refer to the following “Basic Guidelines for Specifying Search Criteria” for
more information. 

If you are searching for an application filed for Auction 24, click 24 in the Auction ID field.

Basic Guidelines for Specifying Search Criteria:

• You must specify search criteria in at least one field.  You do not have to specify search criteria in all of the
search fields.  Enter search criteria into as many fields as you wish.

• To specify search criteria in a search field containing a menu of options, click the desired option from the
menu.   Use the scroll bars to view all options in a menu.  You can select multiple options from a menu by
pressing the CTRL key while you click the menu options.

• Click <No Criteria> to undo a menu selection and search for all options in the menu.

• Click the Clear button to reset entries in all of the search fields.
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• The Universal Licensing System restricts the number of rows returned in an application search to 3000.

Click the ? (Help) button for a definition of each search field available on the Application Search screen.

6. After you have specified the desired search criteria, click the Search button.  The system will scan the database
for any applications matching the search criteria.  The matching application files will be listed on the Search
Results screen.  The Search Results screen will identify the file number, licensee name, application purpose,
application status, radio service code, and receipt date for each application returned in the query.

A message on the Search Results screen will indicate if no matches were found for the specified search criteria. 
Click the New Search button and re-specify search criteria.

7. To view an application, click its file number link.  To navigate through the data on the Application screen, use the
scroll bar or click the links at the top of the screen.  Click the ? (Help) button for information regarding specific
functions available on this screen.

• To re-access the Search Results screen, click the down arrow end of the Other Options field to obtain the
drop-down menu of options.  Click Search Results from the Other Options menu and then click the Go
button.

• To begin a new search, click the down arrow end of the Other Options field to obtain the drop-down menu of
options.  Click New Search and then click the Go button.

Technical Support

For technical assistance in searching the ULS for applications, contact the FCC Technical Support Hotline at (202)
414-1250 (voice) or (202) 414-1255 (TTY).  The FCC Technical Support Hotline is generally available Monday through
Friday, from 8 a.m. to 6 p.m. ET. All calls to the FCC Technical Support Hotline are recorded.



4

Attachment C

ACCESSING THE FCC NETWORK USING WINDOWS 95/98

This attachment describes how to access the FCC Network from a system that is running the Microsoft
Windows 95 or Microsoft Windows 98 operating system.  This involves configuring dial-up network
access and then performing the dial-up procedure.

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including buttons,
Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link, Save option in
the File menu).

italic Represents field names or areas of a screen (e.g., Applicant field, Selected Licenses area
of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions.  For
example, if you are instructed to type http://wtbwww05.fcc.gov, you should type all of the
characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information and then press the
ENTER key.

Hardware and Software Requirements

To connect to the FCC Network using Windows 95/98 Dial-Up Networking requires at a minimum the
following hardware and software:

Hardware Requirements

• CPU: Pentium or above
• RAM:  16 MB (more recommended)
• Monitor:  VGA or above
• Modem: 14.4 kbps, Hayes-compatible or faster (recommended)
• Mouse or other pointing device
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Software Requirements

• Netscape Communicator 4.51 or 4.611.
• Microsoft Windows 95/98

Note:  If you are running Windows in a networked environment, check with your local network
administrator for any potential conflicts with the Windows 95/98 Dial-Up Networking.  This usually
includes any TCP/IP installed network protocol. 

The Windows 95/98 Dial-Up Networking will establish a direct connection from your PC to the FCC
Network.  This point-to-point connection is not routed through the Internet.

Configuring Dial-Up Networking

1. To start dial-up networking:

a. Click the Windows 95/98 Start button. 
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking.

In Windows 98, click Communications, then Dial-Up Networking.

If Dial-Up Networking is not an option on your Accessories menu, you should install it from your
Windows 95/98 CD or diskettes.

2. When the Dial-Up Networking window appears, double-click the Make New Connection icon.

3. The Make New Connection window appears.  In the field entitled Type a name for the computer
you are dialing, type ULS at FCC.

4. In Windows 95, click the down arrow at the right of the Select a modem field and select your
modem from the menu of available modems. 

In Windows 98, click the down arrow at the right of the Select a device field and select your
modem from the menu of available devices.

If your modem does not appear on this list, you must install your modem driver according to the
modem manufacturer installation procedures, which are usually described in your modem’s user
manual.

5. Click the Configure button.  Click the Options tab at the top of the Properties window.

                                               
      Note:  To download Netscape Communicator 4.61 free of charge, access the Netscape download site at
http://home.netscape.com/download/.
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6. In the Connection control area of the Options tab, verify that neither option is selected.  If either
option is selected, click the check box at the left of the option to deselect it.  Then click the OK
button.

7. Click the Next button. 

8. Type 800 in the Area Code field and 844-2784 in the Telephone Number field.  Verify that the
correct country is selected in the Country code field.  If necessary, click the down arrow at the
right of the Country code field and select the appropriate country from the menu of available
countries.

9. Click the Next button.

10. Click the Finish button.  An icon titled ULS at FCC appears in the Dial-Up Networking window.

11. Verify that properties are configured correctly before attempting a dial-up session.  Position the
mouse pointer on the ULS at FCC icon and click the right mouse button to display a menu.  Select
Properties from the menu.

12. Click the Server Types tab at the top of the Properties window.

13. In the Advanced Options area, verify that only Enable software compression is selected. 
If it is not selected, click the check box at the left of the option to select it.  If either of the other
options is selected, click the check box to deselect it.

14. In the Allowed Network Protocols area, verify that only TCP/IP is selected. 

If it is not selected, click the check box at the left of the option to select it.  If either of the other
options is selected, click the check box to deselect it.

15. Click the TCP/IP Settings button and select Specify name server addresses.

16. Type 192.104.54.1 as the Primary DNS. 

17. Click OK on the TCP/IP Settings window and the Server Type window.

18. a. Click the Windows 95/98 Start button, then click the Settings option to display the Settings
menu.

b. Click Control Panel and then double-click the Network icon.

c. Highlight the TCP/IP Protocol and click Properties.  If there are multiple TCP/IP protocols,
highlight TCP/IP --> Dial-Up Adapter and click Properties.

d. Click the DNS Configuration tab.
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e. Select Enable DNS. Type bidder in the Host box, type fcc.gov in the Domain box,  then type
192.104.54.1 in the DNS Server Search Order box and click the Add button.

f. Click OK on the TCP/IP Properties windows, then click OK on the Network window.

g. If you are prompted to restart your computer, click Yes to restart, then begin the Dial-Up
Procedure.

Dial-Up Procedure

1. If the Dial-Up Networking window is not currently open, do the following:

a. Click the Windows 95/98 Start button. 
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d.  In Windows 95, click Dial-Up Networking

In Windows 98, click Communications, then Dial-Up Networking. 

The Dial-Up Networking window appears. 

2. Double-click the ULS at FCC icon in the Dial-Up Networking window.

3. Click the Connect button on the window.  Do not enter User name and Password.

The Connecting window appears, indicating the status of your connection as your modem dials into
the system.  This window must remain running during your dial-up session.  You may minimize the
window, if you wish.

If your modem fails to establish a connection, please see the Troubleshooting section below.

4. Once the connection is established, open your Web browser. 

5. In your browser’s location field, enter http://wtbwww05.fcc.gov.

If nothing appears in your Web browser, please see the Troubleshooting section below.

6. When you have finished, exit the Web browser, then click the Disconnect button on the Connecting
window to end your dial-up session.
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Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating them.

Modem does not respond

1. Confirm that all physical connections for the modem are present.

2. Confirm that the phone line is active by connecting it to a telephone and checking for a dial-tone.

3. Confirm that the correct modem driver is installed for your modem.

Modem dials but does not connect

1. Confirm that the number the modem is dialing is correct.

2. Confirm that the modem prefix, if any, is correct.

Modem dials and connects, but nothing appears when you enter the location in the Web browser 

1. Check the settings in your dial-up networking icon, particularly that the Primary DNS is
192.104.54.1 and that TCP/IP is the only selected protocol.

2. Confirm that your web browser is using no proxies.

3. If you do log into a TCP/IP LAN, confirm that your LAN network IP address is being released.  To
do so, connect to the FCC Network using dial-up networking, then click the Start button in Windows
95/98 and select Run.  Type winipcfg and press OK.  If your IP address does not begin with
“192.104.”, then your LAN IP address is not being released.  Click the Release All button, or consult
you LAN administrator.

Receive an Internal Server error in the Web browser

1. Confirm that the address entered in the location field is correct (http://wtbwww05.fcc.gov).

2. Confirm that JavaScript is enabled in your Web browser.

Technical Support

For technical assistance with installing or using FCC software, contact the FCC Technical Support Hotline
at (202) 414-1250 (voice) or (202) 414-1255 (TTY).  The FCC Technical Support Hotline is generally
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available Monday through Friday, from 8 a.m. to 6 p.m. ET. All calls to the FCC Technical Support
Hotline are recorded.


